RESOURCE AND PATIENT MANAGEMENT SYSTEM

IHS Emergency Department Dashboard

(BEDD)

Addendum to the Installation Guide and Release Notes

Version 2.0 Patch 2
September 2017

Office of Information Technology
Division of Information Technology
# Table of Contents

1.0 Release Notes .................................................................................................................. 1

2.0 Installation Notes ........................................................................................................... 2
   2.1 Contents of Distribution .............................................................................................. 2
   2.2 Required Resources ................................................................................................... 2
   2.3 Before You Begin: Installation Issues ........................................................................ 3

3.0 Installation Instructions .................................................................................................. 4
   3.1 Disk Space .................................................................................................................... 4
   3.2 Pre-installation ............................................................................................................. 4

4.0 Sample Installations ....................................................................................................... 5
   4.1 BEDD XML/Ensemble Installation .............................................................................. 5
      4.1.1 Move XML Compressed File to Accessible Folder and Unzip ......................... 5
      4.1.2 Open Ensemble Studio .................................................................................. 5
      4.1.3 Import the bedd0200.02.xml file ................................................................ 6
   4.2 BEDD KIDS Installation ........................................................................................... 8
   4.3 Sample Cache Install ................................................................................................. 9

5.0 Application Access Setup .............................................................................................. 17
   5.1 Stand Alone Setup .................................................................................................... 17
      5.1.1 EHR Setup ....................................................................................................... 21

Acronym List .......................................................................................................................... 30

Contact Information ............................................................................................................ 31
Preface

The purpose of this manual is to provide the user with the information required to install Version 2.0 Patch 2 of the IHS Emergency Department Dashboard (EDD).
1.0 Release Notes

The EDD is a tool that electronically enables facilities to run and manage their emergency and or urgent care clinics. The EDD is dependent on the Resource and Patient Management System (RPMS) Emergency Room System (ERS) in the AMER namespace. EDD was built on the ERS foundation to enhance patient flow and provider communication.

EDD can be set up to operate as a standalone icon on the staff computer or can be accessed from within the RPMS Electronic Health Record (EHR) application.

EDD gets its data and updates from one of four ways: ERS, Dashboard Edit, or EHR data or a combination of all three.
2.0 Installation Notes

Prefix: BEDD
Current Version: 2.0 Patch 2

2.1 Contents of Distribution

The BEDD v2.0 Patch 2 distribution contains the following items documented in Table 2-1.

Table 2-1: Contents of Distribution

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bedd0200.02.xml</td>
<td>Ensemble XML import file</td>
</tr>
<tr>
<td>bedd0200.02k</td>
<td>KIDS file</td>
</tr>
<tr>
<td>bedd0200.02i.pdf</td>
<td>Addendum to the Installation manual and release notes (this document)</td>
</tr>
<tr>
<td>bedd0200.02t.pdf</td>
<td>Addendum to the Technical manual</td>
</tr>
<tr>
<td>bedd0200.02o.pdf</td>
<td>Addendum to the User guide</td>
</tr>
<tr>
<td>bedd0200.02n</td>
<td>Patch notes</td>
</tr>
</tbody>
</table>

2.2 Required Resources

Table 2-2 contains the RPMS software which is required in order for the BEDD software to run properly.

Table 2-2: Required RPMS software

<table>
<thead>
<tr>
<th>Module</th>
<th>Minimum Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veterans Administration (VA) FileMan (DI)</td>
<td>v22.0 Patch 1003</td>
</tr>
<tr>
<td>VA Kernel (XU)</td>
<td>v8.0 Patch 1015</td>
</tr>
<tr>
<td>IHS/VA Utilities (XB)</td>
<td>v3.0 through Patch 11</td>
</tr>
<tr>
<td>ER Visit System (AMER)</td>
<td>V3.0 Patch 9</td>
</tr>
<tr>
<td>IHS EMERGENCY DEPT DASHBOARD (BEDD)</td>
<td>V2.0 Patch 1</td>
</tr>
<tr>
<td>Patient Care Component PCC Data Entry (APCD)</td>
<td>v2.0 through Patch 10</td>
</tr>
<tr>
<td>IHS PCC Suite (BJPC)</td>
<td>v2.0 Patch 11</td>
</tr>
<tr>
<td>EHR 1.1</td>
<td>v1.1 Patch 14</td>
</tr>
<tr>
<td>Lexicon Utility (LEX)</td>
<td>v2.0 Patch 1003</td>
</tr>
<tr>
<td>Ensemble</td>
<td>v2012.2.5</td>
</tr>
</tbody>
</table>
2.3 Before You Begin: Installation Issues

The Ensemble import file (bedd0200.02.xml) is being delivered in a zipped (compressed) format. It has been determined that transferring the file in an uncompressed format will corrupt it so that it will not import properly into Ensemble. Therefore, when retrieving the file, do not extract the file from its zipped state until it has been placed directly into the desired import folder.
3.0 **Installation Instructions**

The process to install version 2.0 Patch 2 of the BEDD application requires the installation of two builds. The first build that needs to be installed is an XML release that needs to be imported into Ensemble first. Following the XML installation will be a standard KIDS build installation.

3.1 **Disk Space**

With Version 2.0 of BEDD Patch 2, no significant extra disk space is needed on the server to install the Cache Server Page (CSP) and Cache Class files contained in the bedd0200.02.xml file. Additional storage space will be needed to store patient information entered through the EDD.

3.2 **Pre-installation**

Before installing the BEDD application, the following items should be completed (in no particular order):

- If possible, initially load the software into a test account, then into the production account.
- Refer to the sample installation instructions for the applicable prompts and user responses. User responses appear in bold type.
- Ensure the other required applications have been installed.
4.0 Sample Installations

There are two builds which need to be installed with this release, an XML build and a KIDS build. In order for the installation to complete successfully, the KIDS build must be installed after the XML build. A post install step in the KIDS build compiles information delivered in the XML build so it must be installed second. If the KIDS build inadvertently gets installed first, continue and install the XML build and then install the KIDS build a second time.

4.1 BEDD XML/Ensemble Installation

This section begins the BEDD installation process. It describes the process of importing the BEDD application into Ensemble Studio from an XML file.

4.1.1 Move XML Compressed File to Accessible Folder and Unzip

Move the compressed XML build to a folder accessible by the Ensemble server. Once the file has been placed into the folder, unzip the file.

4.1.2 Open Ensemble Studio

1. Click the Ensemble cube in the system tray (at the right end of the Windows Taskbar) and click Studio, as shown in Figure 4-1. A login ID and password may be required.

Figure 4-1: Open Ensemble Studio
2. The Ensemble Studio window is displayed, as shown in Figure 4-2.

3. On the **File** menu, click **Change Namespace** to open the **Cache Connection Manager** dialog box.

![Figure 4-2: Ensemble Studio with option to change namespace](image)

4. Select the appropriate namespace from the **Cache Connection Manager** dialog box and click **OK**, as shown in Figure 4-3.

![Figure 4-3: Select the appropriate namespace to import to](image)

4.1.3 **Import the bedd0200.02.xml file**

1. On the **Tools** menu, click **Import Local** as seen in Figure 4-4.

![Figure 4-4: Tools menu with import option](image)
2. Navigate to the appropriate folder where the file was placed, and select `bedd0200.02.xml` and click **Open** (Figure 4-5), to display the **Import** dialog box, as shown in Figure 4-6.
3. In the Import dialog box, all items in the list need to be selected and Compile Imported Items options needs to be selected.

4. Click OK. After the system compiles the EDD package files, the Compilation finished successfully in… message appears in the Output pane.

5. A warning dialog box similar to Figure 4-7 may be displayed after the XML file has been imported. Click OK to continue.

Figure 4-7: Studio warning dialog box

4.2 BEDD KIDS Installation

1. From the KIDS menu, select the Installation menu.

2. From the XPD Main -> Installation menu, select Option 1: Load a Distribution.

3. Type bedd0200.02k at the “Enter a Host File” prompt. Please note the file path might need to precede the file name with the appropriate host path. This is the file to retrieve from the appropriate software directory.
4. Type **Yes** (or press the ENTER key to accept the default) at the “Want to Continue with Load? YES//?” prompt.

5. KIDS file bedd0200.02k contains the following installation file:

   **BEDD*2.0*2**

6. From the **Installation** menu, select **Option 2: Verify Checksums in Transport Global**. This option provides a mechanism for ensuring the integrity of your routines. This step verifies checksums for the components of the Transport global, and reports any errors uncovered.

7. Type **BEDD*2.0*2** as the install name.

   **Optional:** At this time, you can elect to exercise one of the following installation options. If you elect to use one of these, use **BEDD*2.0*2** as the install name.

   a. Back Up a Transport Global – this option creates a MailMan message that will back up all current routines on the system that would be replaced by this release.

   b. Compare Transport Global – this option allows you to view all changes that will result from the installation of this patch and compares them with the values currently loaded on the system (routines, data dictionaries, templates, etc.).

8. From the **Installation** menu, select the **Install Packages(s)** option.

9. At the **Select Install Name** prompt, type **BEDD*2.0*2**.

10. Respond to the following prompts as indicated:

    a. At the **Want KIDS to Rebuild Menu Trees Upon Completion of Install?** YES// prompt, type **NO**.

    b. At the **Want KIDS to INHIBIT LOGONs during the install?**//YES prompt, type **NO**.

    c. At the **Want to DISABLE Scheduled Options, Menu Options and Protocols?**// YES prompt, type **NO**.

11. Type the device that will print the install messages.

12. Exit the **Installation** menu.

### 4.3 Sample Cache Install

**Note:** User responses appear in bold type.
Select OPTION NAME: **XPD MAIN**  
Kernel Installation & Distribution System

Edits and Distribution ...
Utilities ...
Installation ...
Patch Monitor Main Menu ...

You have PENDING ALERTS
Enter "VA to jump to VIEW ALERTS option

Select Kernel Installation & Distribution System <TEST ACCOUNT> Option:

**Installation**

1. Load a Distribution
2. Verify Checksums in Transport Global
3. Print Transport Global
4. Compare Transport Global to Current System
5. Backup a Transport Global
6. Install Package(s)
   Restart Install of Package(s)
   Unload a Distribution

You have PENDING ALERTS
Enter "VA to jump to VIEW ALERTS option

Select Installation <TEST ACCOUNT> Option: 1  Load a Distribution
Enter a Host File: C:\RPMS\bedd0200.02k

KIDS Distribution saved on Aug 30, 2017@19:35:17
Comment: BEDD*2.0*2

This Distribution contains Transport Globals for the following Package(s):
   BEDD*2.0*2
Distribution OK!

Want to Continue with Load? YES//
Loading Distribution...

Build BEDD*2.0*2 has an Environmental Check Routine
Want to RUN the Environment Check Routine? YES//
   BEDD*2.0*2
Will first run the Environment Check Routine, BEDD2P02

Use INSTALL NAME: BEDD*2.0*2 to install this Distribution.

1. Load a Distribution
2. Verify Checksums in Transport Global
3. Print Transport Global
4. Compare Transport Global to Current System
5. Backup a Transport Global
6. Install Package(s)
   Restart Install of Package(s)
   Unload a Distribution
You have PENDING ALERTS
   Enter "VA to jump to VIEW ALERTS option

Select Installation <TEST ACCOUNT> Option: 2 Verify Checksums in Transport Global
Select INSTALL NAME: BEDD*2.0*2 Loaded from Distribution
8/30/17@19:37:49
   => BEDD*2.0*2 ;Created on Aug 30, 2017@19:35:17

This Distribution was loaded on Aug 30, 2017@19:37:49 with header of
   BEDD*2.0*2 ;Created on Aug 30, 2017@19:35:17
   It consisted of the following Install(s):
   BEDD*2.0*2

Want each Routine Listed with Checksums: Yes// YES
DEVICE: HOME// Virtual
PACKAGE: BEDD*2.0*2 Aug 30, 2017 7:37 pm

-------------------------------------------------------------------------
----

BEDD2P02  Calculated    5417680
BEDDADM   Calculated   93812099
BEDDCPRT  Calculated     36919
BEDDPCC   Calculated    4514773
BEDDPLKP  Calculated   23807225
BEDDPR1T  Calculated   23997061
BEDDUTID  Calculated  183882346
BEDDUTIL  Calculated  169161655

8 Routines checked, 0 failed.

1      Load a Distribution
2      Verify Checksums in Transport Global
3      Print Transport Global
4      Compare Transport Global to Current System
5      Backup a Transport Global
6      Install Package(s)
       Restart Install of Package(s)
       Unload a Distribution

You have PENDING ALERTS
   Enter "VA to jump to VIEW ALERTS option

Select Installation <TEST ACCOUNT> Option: 6 Install Package(s)
Select INSTALL NAME: BEDD*2.0*2 Loaded from Distribution
8/30/17@19:37:49
   => BEDD*2.0*2 ;Created on Aug 30, 2017@19:35:17

This Distribution was loaded on Aug 30, 2017@19:37:49 with header of
   BEDD*2.0*2 ;Created on Aug 30, 2017@19:35:17
   It consisted of the following Install(s):
   BEDD*2.0*2
Checking Install for Package BEDD*2.0*2
Will first run the Environment Check Routine, BEDD2P02

Install Questions for BEDD*2.0*2

Want KIDS to INHIBIT LOGONs during the install? NO//
Want to DISABLE Scheduled Options, Menu Options, and Protocols? NO//

Enter the Device you want to print the Install messages.
You can queue the install by enter a 'Q' at the device prompt.
Enter a '^^' to abort the install.

DEVICE: HOME// Virtual

Install Started for BEDD*2.0*2 :
   Aug 30, 2017@19:37:58

Build Distribution Date: Aug 30, 2017

Installing Routines:
   Aug 30, 2017@19:37:58

Running Post-Install Routine: ENT^BEDD2P02
Compilation started on 08/30/2017 19:37:59 with qualifiers 'k-u'
Compiling routine : BEDD2XML.INT
Compiling routine : BEDDRPT.INT
Compiling routine : BEDDUTIS.INT
Compiling routine : BEDDUTW.INT, compiling 18 classes
Compiling class BEDD.EDConsults
Compiling class BEDD.EDDiagnosis
Compiling class BEDD.EDInjury
Compiling class BEDD.EDProc
Compiling class BEDD.EDRoomUse
Compiling class BEDD.EDRooms
Compiling class BEDD.EDSYSTEM
Compiling class BEDD.EDUserPreferences
Compiling class BEDD.EDWarning
Compiling class BEDDAPPL.EDMenu
Compiling class BEDDAPPL.EDRoomModel
Compiling class BEDDAPPL.EDSystemModel
Compiling class BEDDAPPL.EDWarningModel
Compiling class BEDD.EDVISIT
Compiling table BEDD.EDConsults
Compiling table BEDD.EDDiagnosis
Compiling table BEDD.EDProc
Compiling table BEDD.EDRoomUse
Compiling table BEDD.EDRooms
Compiling table BEDD.EDSYSTEM
Compiling table BEDD.EDUserPreferences
Compiling table BEDD.EDVISIT
Compiling table BEDD.EDWarning
Compiling routine BEDD.EDConsults.1
Compiling routine BEDD.EDDiagnosis.1
Compiling routine BEDD.EDInjury.1
Compiling routine BEDD.EDProc.1
Compiling routine BEDD.EDRoomUse.1
Compiling routine BEDD.EDRooms.1
Compiling routine BEDD.EDSYSTEM.1
Compiling routine BEDD.EDUserPreferences.1
Compiling routine BEDD.EDWarning.1
Compiling routine BEDDAPPL.EDMenu.1
Compiling routine BEDDAPPL.EDRoomModel.1
Compiling routine BEDDAPPL.EDSystemModel.1
Compiling routine BEDDAPPL.EDWarningModel.1
Compiling routine BEDD.EDVISIT.1
Generating file: D:\intersystems\E3IHS\CSP\test7\BEDDAPPL.js
Generating file: D:\intersystems\E3IHS\CSP\test7\BEDDAPPL.css
Generating file: D:\intersystems\E3IHS\CSP\test7\BEDDAPPL_3.css
Compiling class BEDDAPPL.EDManager
Compiling class BEDDAPPL.EDRoom
Compiling class BEDDAPPL.EDSystem
Compiling class BEDDAPPL.EDWarning
Compiling routine BEDDAPPL.EDManager.1
Compiling routine BEDDAPPL.EDRoom.1
Compiling routine BEDDAPPL.EDSystem.1
Compiling routine BEDDAPPL.EDWarning.1
Compiling file /csp/test7/BEDD.csp
Compiling file /csp/test7/BEDDASRPT.csp
Compiling file /csp/test7/BEDDCTMRPT.csp
Compiling file /csp/test7/BEDDCLOGRPT.csp
Compiling file /csp/test7/BEDDCONS.csp
Compiling file /csp/test7/BEDDDC.csp
Compiling file /csp/test7/BEDDDCITMRPT.csp
Compiling file /csp/test7/BEDDIAG.csp
Compiling file /csp/test7/BEDDEDC.csp
Compiling file /csp/test7/BEDDEDCV.csp
Compiling file /csp/test7/BEDDEDIT1.csp
Compiling file /csp/test7/BEDDIL.csp
Compiling file /csp/test7/BEDDINJ.csp
Compiling file /csp/test7/BEDDLCKIT.csp
Compiling file /csp/test7/BEDDLCKREL.csp
Compiling file /csp/test7/BEDDLOGIN.csp
Compiling file /csp/test7/BEDDLOGIN1.csp
Compiling file /csp/test7/BEDDLOGIN1.csp
Compiling file /csp/test7/BEDDPROC.csp
Compiling file /csp/test7/BEDDRMTMRPT.csp
Compiling file /csp/test7/BEDDRPTMNU.csp
Compiling file /csp/test7/BEDDTRG.csp
Compiling file /csp/test7/BEDDUA.csp
Compiling file /csp/test7/BEDDUNLOCK.csp, compiling 24 classes
Compiling class csp.bedd
Compiling class csp.beddasrpt
Compiling class csp.beddcitmrpt
Compiling class csp.beddclgrpt
Compiling class csp.beddcons
Compiling class csp.bedddc
Compiling class csp.beddctmrpt
Compiling class csp.bedddiag
Compiling class csp.beddedc
Compiling class csp.beddedcv
Compiling class csp.beddedit1
Compiling class csp.beddil
Compiling class csp.beddinj
Compiling class csp.beddlckit
Compiling class csp.beddckrel
Compiling class csp.beddlogin
Compiling class csp.beddlogin1
Compiling class csp.beddlosrpt
Compiling class csp.beddproc
Compiling class csp.beddrmtmrpt
Compiling class csp.beddrptmnu
Compiling class csp.beddtrg
Compiling class csp.beddua
Compiling class csp.beddunlock
Compiling routine csp.bedd.l
Compiling routine csp.beddasrpt.l
Compiling routine csp.beddcitmrpt.l
Compiling routine csp.beddclogrpt.l
Compiling routine csp.beddcons.l
Compiling routine csp.beddcc.l
Compiling routine csp.bedddctmrpt.l
Compiling routine csp.bedddiag.l
Compiling routine csp.bedddec.l
Compiling routine csp.bedddecv.l
Compiling routine csp.beddedit1.l
Compiling routine csp.beddil.l
Compiling routine csp.beddinj.l
Compiling routine csp.beddlckit.l
Compiling routine csp.beddlckrel.l
Compiling routine csp.beddlogin.l
Compiling routine csp.beddlogn.l
Compiling routine csp.beddiosrpt.l
Compiling routine csp.bedddproc.l
Compiling routine csp.beddrmtmrpt.l
Compiling routine csp.beddrptmnu.l
Compiling routine csp.beddtrg.l
Compiling routine csp.beddua.l
Compiling routine csp.beddunlock.l
Compilation finished successfully in 9.646s.

Compilation started on 08/30/2017 19:38:08 with qualifiers 'k-u'
Compiling routine : BEDD2X01.INT
Compiling routine : BEDDPREF.INT
Compiling routine : BEDDUTIS.INT
Compiling routine : BEDDUTW.INT
Compiling routine : BEDDUTW1.INT, compiling 6 classes
Compiling class BEDD.EDSYSTEM
Compiling class BEED.EDUserPreferences
Compiling class BEED.EDVISIT
Compiling class BEDDAPPL.EDMenu
Compiling class BEDDAPPL.EDSystemModel
Compiling table BEDD.EDSYSTEM
Compiling table BEDD.EDUserPreferences
Compiling table BEDD.EDVISIT
Compiling routine BEDD.EDSYSTEM.l
Compiling routine BEED.EDUserPreferences.l
Compiling routine BEED.EDVISIT.l
Compiling routine BEDDAPPL.EDMenu.l
Compiling routine BEDDAPPL.EDSystemModel.l
Generating file: D:\intersystems\E3IHS\CSP\test7\BEDDAPPL.js
Generating file: D:\intersystems\E3IHS\CSP\test7\BEDDAPPL.css
Generating file: D:\intersystems\E3IHS\CSP\test7\BEDDAPPL_3.css
Compiling class BEDDAPPL.EDSystem
Compiling routine BEDDAPPL.EDSystem.l
Compiling file /csp/test7/BEED.csp
Compiling file /csp/test7/BEDEDIT1.csp
Compiling file /csp/test7/BEEDLCKIT.csp
Compiling file /csp/test7/BEEDLCKREL.csp
Compiling file /csp/test7/BEDDLogin1.csp
Compiling file /csp/test7/BEDDPROC.csp, compiling 6 classes
Compiling class csp.bedd
Compiling class csp.beddedit1
Compiling class csp.beddlckit
Compiling class csp.beddlckrel
Compiling class csp.beddlogin1
Compiling class csp.beddproc
Compiling routine csp.bedd.1
Compiling routine csp.beddedit1.1
Compiling routine csp.beddlckit.1
Compiling routine csp.beddlckrel.1
Compiling routine csp.beddlogin1.1
Compiling routine csp.beddproc.1
Compilation finished successfully in 3.661s.

Compilation started on 08/30/2017 19:38:12 with qualifiers 'k-u'
Compiling routine : BEDD2X02.INT
Compiling routine : BEDDRPT.INT
Compiling routine : BEDDUTW.INT
Compiling routine : BEDDUTW1.INT, compiling 6 classes
Compiling class BEDD.EDSYSTEM
Compiling class BEDDAPPL.EDMenu
Compiling class BEDDAPPL.EDSystemModel
Compiling table BEDD.EDSYSTEM
Compiling routine BEDD.EDSYSTEM.1
Compiling routine BEDDAPPL.EDMenu.1
Compiling routine BEDDAPPL.EDSystemModel.1
Generating file: D:\intersystems\E3IHS\CSP\test7\BEDDAPPL.js
Generating file: D:\intersystems\E3IHS\CSP\test7\BEDDAPPL.css
Generating file: D:\intersystems\E3IHS\CSP\test7\BEDDAPPL_3.css
Compiling class BEDDAPPL.EDRoom
Compiling class BEDDAPPL.EDSystem
Compiling class BEDDAPPL.EDWarning
Compiling routine BEDDAPPL.EDRoom.1
Compiling routine BEDDAPPL.EDSystem.1
Compiling routine BEDDAPPL.EDWarning.1
Compiling file /csp/test7/BEDD.csp
Compiling file /csp/test7/BEDDAdmit.csp
Compiling file /csp/test7/BEDDCLOGRPT.csp
Compiling file /csp/test7/BEDDCONS.csp
Compiling file /csp/test7/BEDDDC.csp
Compiling file /csp/test7/BEDDDIAG.csp
Compiling file /csp/test7/BEDDEDC.csp
Compiling file /csp/test7/BEDDEDCV.csp
Compiling file /csp/test7/BEDDEdit1.csp
Compiling file /csp/test7/BEDDINJ.csp
Compiling file /csp/test7/BEDDLCKIT.csp
Compiling file /csp/test7/BEDDLCKREL.csp
Compiling file /csp/test7/BEDDLogin.csp
Compiling file /csp/test7/BEDDLogin1.csp
Compiling file /csp/test7/BEDDPROC.csp
Compiling file /csp/test7/BEDDRPTMNU.csp, compiling 16 classes
Compiling class csp.bedd
Compiling class csp.beddadmit
Compiling class csp.beddclogrpt
Compiling class csp.beddcons
Compiling class csp.bedddc
Compiling class csp.bedddiag
Compiling class csp.bedddec
Compiling class csp.bedddcv
Compiling class csp.beddedit1
Compiling class csp.beddinj
Compiling class csp.beddlckit
Compiling class csp.beddlckrel
Compiling class csp.beddlogin
Compiling class csp.beddlogin1
Compiling class csp.beddproc
Compiling class csp.beddreport
Compiling routine csp.bedd.1
Compiling routine csp.beddadmit.1
Compiling routine csp.beddclogrpt.1
Compiling routine csp.beddclogin
Compiling routine csp.bedddiag.1
Compiling routine csp.beddclog
Compiling routine csp.bedddc.1
Compiling routine csp.bedddcv.1
Compiling routine csp.bedde.1
Compiling routine csp.beddc.1
Compiling routine csp.beddedit1.1
Compiling routine csp.beddinj.1
Compiling routine csp.beddlckit.1
Compiling routine csp.beddlckrel.1
Compiling routine csp.beddlogin1
Compiling routine csp.beddlogin1.1
Compiling routine csp.beddproc.1
Compiling routine csp.beddreport.1
Compilation finished successfully in 4.397s.

Compilation started on 08/30/2017 19:38:16 with qualifiers 'k-u'
Compilation finished successfully in 0.005s.

Updating Routine file...
Updating KIDS files...
BEDD*2.0*2 Installed.
   Aug 30, 2017@19:38:16

Not a VA primary domain
Install Completed

Figure 4-8: Sample installation
5.0 Application Access Setup

If the EDD is accessed at the site by being opened by a menu option in EHR, changes included with BEDD Version 2.0 Patch 2 require that a change be made to the setup of this configuration. Please see section 5.1.2.2 for instructions on making this required setting change.

There are two modes of operation for the EDD: Standalone and EHR Portal.

1. **Standalone Mode** - access via a direct web browser session which requires an active RPMS Access and Verify code to login.

   **Note:** The setup for this step has changed from what was done for previous BEDD releases. Existing links to the EDD will need to be deleted and replaced with the new links described below.

2. **EHR Application Access** – There are now two ways to set up the EDD to work from within the EHR Application. The EDD can be set up from within EHR as a separate tab or it can be set up as a menu option, which when selected, will open up the EDD in a separate browser window. Note that this also requires an active RPMS Access and Verify code and the appropriate BEDD security keys to login. BEDD Version 2.0 Patch 2 also requires that existing menu options be modified in order to continue to work properly.

5.1 Stand Alone Setup

For Standalone access, create an icon on your desktop to call up your web browser for access:

1. If there is already a shortcut on the desktop for the ED Dashboard, right-click on the shortcut icon and select **properties**. On the **Shortcut** tab, copy the string located in the **Target** field for later use.

2. On your desktop or from the **Start** menu, right-click on the Internet Explorer icon and choose **Send to ➔ Desktop** (create shortcut) (Figure 5-1):
3. Locate the new shortcut on the desktop, right click and select **properties**. Navigate to the **General** tab and change the name of the shortcut to the desired value (see Figure 5-2).

![Figure 5-1: Create Standalone Access Shortcut](image)
4. Navigate to the **Shortcut** tab. In the target field, leaving what is currently listed there and appending to the end, adding the following:

- A space followed by **-nomerge** (do not copy and paste this information into the link. Instead type it by hand)
- A space followed by the target information copied in Step 1 above. If a Standalone shortcut was not previously set up, this string will be as follows:

  ![Image](image_url)

  **Figure 5-2: Renaming the New Shortcut**

```plaintext
http://IPADDRESS:PORT/csp/bedd/BEDDLogin.csp
```

Where:

- **IPADDRESS** is the IP name or Address of your Ensemble installation or CSP Gateway
- **PORT** is the port number used for the portal or gateway

**Note:** Modify the URL to HTTPS if you are using a CSP gateway with an active and signed HTTPS encryption certificate.

- The resulting Target value should look similar to the following example (See Figure 5-3):

  ```plaintext
  "C:\Program Files\Internet Explorer\iexplore.exe" -nomerge
  http://URL:PORT/csp/bedd/BEDDLogin.csp
  ```
Where URL and PORT represent the proper values for your site.

5. Click OK to save the changes

6. Click the new icon to test. Depending on the Ensemble settings, one of the following two pages shown in Figure 5-4 or Figure 5-5 should be presented:

   • Ensemble Login Credential Request (Figure 5-4) – Log into Ensemble with the appropriate login User Name and Password.
Figure 5-4: Ensemble Login Request

- ED Dashboard Login Credential Request (Figure 5-5) – Log into the ED Dashboard using your personal ACCESS/VERIFY codes or the Whiteboard login credentials.

Figure 5-5 ED Dashboard Login Request

5.1.1 EHR Setup

EHR application managers can choose which method they would like to allow users to view the EDD from the EHR application.

5.1.1.1 EDD New EHR Tab Method

To set up users to access the EDD from within EHR on a new EHR tab, perform the following steps:
1. Open, EHR, right-click in the title bar at the top and choose **Design Mode** as indicated in Figure 5-6.

![Figure 5-6: EHR Design Mode](image)

2. From the **Design** menu option, select **Layout Manager** as in Figure 5-7.

![Figure 5-7: EHR Layout Manager](image)

3. In the **Layout Manager**, click on **Tabbed Notebook** and click **Properties** as shown in Figure 5-8:
4. In the **Tabbed Notebook** dialog, click on the “+” icon in the **Tab Editor** property as shown in Figure 5-9:

5. In the new tab, type **ED Dashboard** (or the name that is to be used for the ED Dashboard) as shown in Figure 5-10:
6. After creating the new tab, step to the tab. Right-click on the tab space and select **Add Object** as shown in Figure 5-11:
7. Select to add a new **Internet Explorer** object as shown in Figure 5-12:

8. Right click on the new **Internet Explorer** object and select **Properties** as shown in Figure 5-13:
9. In the **HOMEPAGE** property box, put in the EHR URL as seen in Figure 5-14, where an example value is given. Replace IP address and PORT values with those appropriate for your site.

http://IPaddress:PORT
csp/bedd/BEDDLogin.csp?DUZ=$(user.handle)&SITE=$(site.handle)&LOC=EHR
5.1.1.2 EDD New EHR Menu Method

BEDD Version 2.0 Patch 2 requires that a small change be made to allow this method of accessing the EDD to continue to function properly. Please see below for a listing of the needed change. To set up users to access the EDD from a new browser window accessible from a menu option in EHR, perform the following steps:

1. Open EHR, right-click in the title bar at the top and choose **Design Mode** as indicated in Figure 5-15.

![Figure 5-15: Enter Design Mode](image)

2. Select **Design -> Desktop Properties** as displayed in Figure 5-16.

![Figure 5-16: Desktop Properties](image)
3. Select **Customize Menus** as displayed in Figure 5-17. Click “+” to add and enter a new menu option **ED Dashboard** as seen in Figure 5-18.

![Figure 5-17: Customize Menus](image1)

![Figure 5-18: Customize Menus cont'd](image2)

4. Click the lightning bolt icon in the display. In the **Edit Action Box** that appears, put in the path to Internet Explorer followed by a space, `-nomerge`, another space followed by the regular EHR URL as seen in Figure 5-19, where an example value is given. Replace IP address and PORT values with those appropriate for your site.
C:\Program Files\Internet Explorer\iexplore.exe -nomerge
http://IPaddress:PORT
csp/bedd/BEDDLogin.csp?DUZ=$(user.handle)&SITE=$(site.handle)&LOC=SA

Note: For BEDD releases prior to Version 2.0 Patch 2 the above string ended with LOC=EHR. With the release of Version 2.0 Patch 2 the string should now end with LOC=SA.

Figure 5-19: Edit action

5. Click **OK**, **Save Settings** and leave design mode.

6. Click on the new menu option **ED Dashboard**, and the EDD main screen will display as indicated in Figure 5-20.

Figure 5-20 ED Dashboard Display
## Acronym List

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSP</td>
<td>Cache Server Page</td>
</tr>
<tr>
<td>EDD</td>
<td>Emergency Department Dashboard</td>
</tr>
<tr>
<td>EHR</td>
<td>Electronic Health Record</td>
</tr>
<tr>
<td>ERS</td>
<td>Emergency Room System</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>IHS</td>
<td>Indian Health Service</td>
</tr>
<tr>
<td>IIS</td>
<td>Internet Information Services</td>
</tr>
<tr>
<td>RPMS</td>
<td>Resource and Patient Management System</td>
</tr>
<tr>
<td>SSL</td>
<td>Secure Sockets Layer</td>
</tr>
</tbody>
</table>
Contact Information

If you have any questions or comments regarding this distribution, please contact the OIT Help Desk (IHS).

Phone:  (888) 830-7280 (toll free)
Web:    http://www.ihs.gov/helpdesk/
Email:  support@ihs.gov